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  اندنوتمعرفي 

اطلاعات و استنادها در روند پژوهش است که امروزه  منابع، يکي از بهترين و جامع ترين نرم افزارهاي مديريتاندنوت نرم افزار 

اي، هوشمند و ساده اي را در اختيار  محيط حرفه اندنوتنرم افزار شود. به طور گسترده توسط پژوهشگران استفاده مي 

ذخيره شده  اندنوت( و يا با استفاده از کتابخانه Onlineبا اتصال به اينترنت )به صورت اين نرم افزار کاربران قرار مي دهد. 

با فرمت هاي گوناگون دريافت و رفرنس گذاري ( مي تواند اطلاعات مربوط به مقالات و يا پايان نامه ها را Offline)به صورت 

تمامي ويژگي هاي مقالات از جمله اسامي نويسندگان، عنوان، زبان، چکيده، سال انتشار، نام مجله و  اندنوتنمايد. در کتابخانه 

 با کمک اين نرم افزار مي توانيد:... در اختيار کاربران قرار مي گيرد. 

  کنيدبي دلخواه و يکسان مرتب در قالاستنادهاي مقالات خود را. 

 .در ميان منابع پژوهشي خود به راحتي به جستجو بپردازيد 

 .تصاوير، جداول، نمودارها، و متن مقالات مورد نياز خود را ذخيره نماييد 

 .هم زمان با نوشتن مقاله، استنادها را با هر شيوه دلخواه به متن اضافه کنيد 

 جديد زير است:  داراي ويژگي هاي اندنوتنسخه جديد 

نسخه جديد به شما امکان مي دهد ببينيد چگونه همکارانتان، کتابخانه به اشتراک گذاشته شده خود را، به روز کرده  .1

 .اند

 .Word 2016استناد در هنگام نوشتن در  .2

 به اشتراک گذاشتن کتابخانه شخصي با اعضاي تيم و همکاران، که شما شخصا دعوت نموده ايد. .3

 ا متخصصان و کاربران اندنوت از سراسر جهان تماس بگيريد.مي توانيد ب .4

 افزودن رفرنس به فايل هاي پاورپوينت .5

 وردگروهبندي رفرنسها در فايل  .6

 PDFبهبود جستجوي سريع با جستجوي چند جمله اي در تمام فيلدها، شامل جستجو در فايل هاي  .7

 

 روش نصب نرم افزار

. مي توانيد فايل نصب اين نرم وع نماييد لازم است آن را بر روي کامپيوتر خود نصب کنيدپيش از اين که کار با نرم افزار را شر

نرم  ،کليک بر روي فايل اجرايي دو باربا دريافت نماييد. افزار را از کتابخانه واحد هاي مختلف دانشگاه )دانشکده يا بيمارستان( 

 را بزنيد.  nextکپي نماييد و گزينه  reg.txtايل را از ف product key افزار را نصب نماييد. در جريان نصب
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به اين ترتيب تا آخرين مرحله، نصب را ادامه دهيد. بعد از آن نرم افزار بر روي سيستم شما نصب شده است و مي توايد از آن 

 استفاده نماييد. 

 

 چگونه يک کتابخانه شخصي بسازيم؟

تعداد زيادي از منابع و ماخذ را ذخيره مي درست همانند يک کتابخانه،  Endnote Libraryا ي اندنوتکتابخانه شخصي  

 نمايد. براي ساختن يک کتابخانه شخصي مراحل زير را انجام دهيد.

 را اجرا نماييد.  Start> All program>Endnote از منوي .1

 

 

 انتخاب کنيد. را Newگزينه  File، از منوي براي ساختن يک فضاي کار جديد اندنوت در پنجره   .2
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 Fileمکان مورد نظر براي ذخيره کردن فايلتان را انتخاب کنيد؛ در قسمت  Save inدر پنجره جديد، در قسمت  .3

Name .عنواني براي کتابخانه شخصي خود برگزينيد 

 کليک نماييد. Saveروي کليد  .4
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محل ذخيره کليه  Dataدارد. پوشه  "Data"وند نکته: کتابخانه شخصي شما، در کنار خود پوشه اي با همان نام و با پس

نموده ايد. لذا براي دسترسي به فايل هاي ضميمه، لازم  (attach)فايل هايي است که به منابع موجود در کتابخانه ضميمه 

 را نيز همراه آن جابجا نماييد. Dataاست هنگام جابجا نمودن کتابخانه شخصي پوشه 

 مروري در پنجره کتابخانه

ليستي از همه رفرنس ها ي موجود در کتابخانه نمايش داده مي شود. ي که شما يک پنجره کتابخانه را باز مي کنيد، زمان

 است: فضاي کار )پنل(  4 کتابخانه شامل  پنجره
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 شامل گروه سفارشي، گروه هوشمند، گروه : گروه هاي مختلف رفرنس را براي بازيابي آسان نمايش مي دهد. پنل گروه ها .1

 ترکيبي و .....
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: اين پنل يک ليست چند ستوني از رفرنس ها را نمايش مي دهد. به صورت پيش فرض ستون ها پنل ليست رفرنس ها .2

 موارد زير را نمايش مي دهند:

  جهت نشان دادن اينکه رفرنس شامل فايل ضميمه است. "گيره"آيکون 

 نام خانوادگي نويسنده و نام کوچک 

 سال 

 عنوان 

 رتبه بندي 

  مجلهنام 

 نوع رفرنس 

 URL 

 آخرين روزآمدسازي 

 

 : نکته

 بخش هر بالاي هاي تب روي کار اين براي. دهيد تغيير را هستند منابع ليست در که فيلدهايي نظم توانيد مي شما 

  .دهد تغيير نزولي يا صعودي صورت به را بخش آن تنظيمات تا نماييد کليک...  و Author, Year مانند

 انيد فيلد هاي موجود در ليست را با استفاده از منويهمچنين مي تو Edit> Preferences> Display 

fields .تغيير دهيد 

 : اين پنل موارد زير را نمايش مي دهد: پنل زبانه ها )تب ها( .3

 گزينه Reference  مي  گزينهجهت نمايش محتويات رفرنس در فيلدهاي جداگانه و ويرايش آن. با استفاده از اين

 نيد به سرعت رفرنس هاي خود را ويرايش نماييدتوا



 Endnote X8راهنمای آموزشی 

 دانشگاه علوم پزشکي شيراز 8 

 

  گزينه Preview  جهت نمايش فرمت خروجي رفرنس ها با توجه بهStyle انتخاب شده 

 گزينه Attach PDFs  جهت نمايش فايلهايPDF متصل شده به رفرنس ها 

  جهت اتصال فايل به هر رفرنس )فقط فايل هاي   "گيره"آيکونPDF س در پنل تب متصل شده به هر رفرن

 ها نمايش داده مي شود.(
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مي توان جهت جستجو در رفرنس هاي موجود ،  Online search: از اين پنل  علاوه بر جستجو در قسمت پنل جستجو .4

نمايش يا به صورت پيش فرض پنل جستجو در بالاي پنجره اندنوت قرار دارد. جهت در کتابخانه شخصي نيز استفاده نمود. 

 کليک نماييد.  Hide search panelنل جستجو بر روي کليد مخفي کردن پ

 

 

 پنل جستجو شامل موارد زير است:

 منطقي هايليست عملگر .1

 ليست فيلدها .2

 ليست تطبيق .3

 زمينه هاي جستجو .4

 نکاتي در باره جستجو:

  اندنوت امکان جستجو در فايل هايPDF يب که در که به رفرنس ها متصل شده اند را فراهم مي کند. به اين ترت

. رفرنس دو کليدواژه مورد نظر را وارد کني کردهرا انتخاب  Any field+ Pdf with notesپنل جستجو فيلد 

 .خواهد گرديد موجود باشد بازيابي آنها اين کليدواژه PDFهايي که در فايل 

 دن کليدواژه ها و تعيين مي توان استراتژي جستجوي خود در اندنوت را ذخيره نماييد. براي اينکار بعد از وارد کر

از گزينه  به اين ترتيب دفعات بعد مي توان .درا انتخاب نمايي Option> Save searchفيلدها از گزينه 

Option> Load search   نمودبراي بازيابي استراتژي جستجوي قبلي استفاده. 

 

واقع در سمت راست پايين  Layoutوي را مي توان از طريق من Endnote libraryپنل موجود در  4نمايش  نحوه: نکته

 .تغيير داد صفحه
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  (Window layout)انتخاب طرح پنجره کتابخانه 

که در گوشه سمت راست پايين  layoutپنجره کتابخانه با توجه به طرحي که از منوي نحوه نمايش پنل هاي موجود در 

 طرح در اين منو وجود دارد.  7انتخاب مي نماييد، متغير است. 

 گروه ها پنل 

Left/Off را مي توانيد در ترکيب با هر يک گروه انتخاب کنيد. اين طرح  پنل: اين طرح را براي مخفي کردن و يا نشان دادن

 از طرحهاي ديگر انتخاب نماييد.

  :پنل رفرنس 

Right اين طرح تب هاي رفرنس، پيش نمايش و نمايش :PDF اندنوت به  را در يک ترتيب ستوني قرار مي دهد. )تنظيمات

 صورت پيش فرض به اين شکل است.(

Right- split اين طرح تب هاي رفرنس و پيش نمايش را در يک ستون و تب نمايش :PDF ديگر به  نرا در يک ستو

 موازات هم نمايش مي دهد. 

Bottom اين طرح تب هاي رفرنس، پيش نمايش و نمايش :PDF ي دهد. را در يک رديف در پايين پنل رفرنس نمايش م 

Bottom – Split : اين طرح تب هاي رفرنس و پيش نمايش را در يک ستون و تب نمايشPDF  را در يک ستون ديگر به

 موازات هم و در پايين پنل رفرنس نمايش مي دهد. 

Off اين طرح تب هاي رفرنس، پيش نمايش و نمايش :PDF .را مخفي مي نمايد 
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 (Mode)انتخاب حالت نمايش 

 ر ابزار موجود در پنجره کتابخانه اندنوت سه حالت نمايش وجود دارد:در نوا

1. Local library mode  اين حالت گروه هاي مختلف را نمايش مي دهد ولي :Online group   را نشان نمي

 دهد. اين حالت به صورت پيش فرض انتخاب شده است.

 

 

2. Online search mode در اين حالت فقط گروه :Online search  وجود دارد. زماني که شما رفرنس هايي را از

پايگاه هاي آنلاين جستجو مي کنيد، رفرنس ها در يک گروه موقت ذخيره مي شوند تا زماني که آنها را به کتابخانه 

آنرا به    اصلي منتقل نماييد. براي انتقال، رفرنس هاي مورد نظر را انتخاب کنيد و با کليک بر روي آيکون

 اصلي منتقل نماييد. کتابخانه

 

 

3. Integrated library & online search mode.در اين حالت، همه موارد دو حالت قبل مشاهده مي شود : 
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 مرتب کردن رفرنس ها

 شما مي توانيد رفرنس ها را با کليک کردن بر روي نوار بالاي هر ستون مانند عنوان، نويسنده، سال و ... مرتب کنيد.

 

 

 ز کردن و بستن رفرنس هاانتخاب، با

 :راه هاي مختلفي براي انتخاب رفرنس وجود دارد مانند 

 کليک کردن بر روي رفرنس .1

 استفاده از کليدهاي حرکتي بر روي کيبورد .2

 تايپ کردن چند حرف از کلمات موجود در فيلدهاي رفرنس مورد نظر .3

 پنجره رفرنس تمام اطلاعات مربوط به رفرنس  با دوبار کليک کردن بر روي هر رفرنس مي توانيد آنرا باز کنيد. در

 نمايش داده مي شود. در اين پنجره مي توانيد اطلاعات مربوط به رفرنس را وارد و يا ويرايش نماييد.

 :مي توانيد به يکي از روش هاي زير رفرنس ها را ببنديد 

 در گوشه بالاي پنجره رفرنس Xبا کليک بر روي دکمه بستن  .1

  File> Close reference انتخاب .2

 کيبورد Ctrl + W انتخاب .3

 توجه داشته باشيد که بسياري از دستورات يک معادل در صفحه کليد دارد که در کنار آن نوشته شده است. .4

 تنظيمات

  تنظيمات همگام سازيSync Library : در نوار ابزار اندنوت و يا از  براي انجام اين تنظيمات يا از گزينه

اين تنظيمات به شما اجازه مي دهد نام کاربري و رمز عبور خود استفاده نماييد.  Edit>Preferences>Syncمنوي 

 را که مربوط به اندنوت وب است، ذخيره نماييد. 
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 PDF handling اين تنظيمات امکان تعريف تغيير نام خودکار اسناد :PDF  ،را که به کتابخانه اندنوت وارد مي نماييد

که به  PDFراي مدارک و نامهاي قابل جستجوي آسانتر ب انجام دهيد ترتوانيد سازماندهي به فراهم مي کند. شما مي

 کتابخانه اندنوت وارد مي شود، ايجاد کنيد.:

 را انتخاب نماييد. Edit> Preferences> PDF handlingابتدا  .1
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 Don’tد. به صورت پيش فرض گزينه خود را انجام دهي PDFبالا مي توانيد تغييرات مورد نظر بر روي اسناد  پنلدر  .2

rename  انتخاب شده است. گزينه هاي ديگر به شما اجازه مي دهد يک روش شخصي براي تغيير نام اسنادPDF 

 بسازيد.

نام دارد. در اين قسمت شما مي  "PDF auto import folder"گزينه ديگري که در اين قسمت وجود دارد  .3

در مشخص بر روي کامپيوترتان افزوده مي شود، را به کتابخانه اندنوت بيفزاييد. که به يک فول PDFتوانيد هر فايل 

را براي انتقال به اندنوت در نظر گرفته ايد کاربرد دارد. براي  PDFاين روش براي زماني که شما يک فولدر از فايلهاي 

گزينه  PDF auto import folder پنلدر  Preferences> PDF handlingتنظيم اين بخش در پنجره 

Enable automatic importing  را تيک بزنيد و فولدر مورد نظر خود را با کليک بر روي گزينهSelect 

folder  انتخاب نماييد. با کليک بر رويOK .توضيحات در باره چگونگي وارد کردن فايل تغييرات را ذخيره نماييد( 

 راهنما( 25در صفحه  PDFهاي 
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 Display fieldتفاده از اين قسمت در پنجره : با اسPreferences  ،مي توانيد ترتيب نمايش فيلدها )نويسنده

 رفرنس در پنجره اندنوت را تنظيم نماييد. پنلعنوان، سال, نام ژورنال و....( در 

 

 Display font حروف در بخش هاي مختلف پنجره اندنوت را تنظيم  توانيد نوع فونت و سايز: در اين بخش مي

 د.نمايي

 ورود اطلاعات به نرم افزار

 ورود اطلاعات به صورت دستي.1

چند روش براي ورود اطلاعات به نرم بعد از اين که کتابخانه شخصي خود را ساختيد، نوبت به ورود اطلاعات منابع مي رسد. 

ورتي يک رکورد را دستي . توصيه مي شود تنها در صاست دستي ، به صورتاطلاعاتافزار اندنوت وجود دارد. اولين روش ورود 

به صورت  وارد نماييد که نتوانيد اطلاعات آن را از اينترنت به کتابخانه شخصي وارد نماييد. براي ورود اطلاعات يک رکورد

 دستي:

  از منويReference  گزينهNew Reference را    را انتخاب نماييد يا در نوار ابزار بالاي صفحه گزينه

 انتخاب کنيد.



 Endnote X8راهنمای آموزشی 

 دانشگاه علوم پزشکي شيراز 16 

 

  باز شدن فرم ورود اطلاعات، ابتدا در قسمت بعد ازReference Type  نوع ماخذ )براي مثالbook, journal 

article .و...( را انتخاب نماييد. اطلاعات درخواستي فرم، مطابق با نوع ماخذ انتخابي تغيير مي کند 

 .در هر قسمت از فرم، با کليک بر روي هر خانه اطلاعات را تايپ نماييد 

 

 

 نتخاب منوي با اFile  گزينهClose reference  و يا با بستن پنجره فرم، از شما سوال مي شود که تغييرات

 اين ماخذ در کتابخانه شما ذخيره مي شود.را انتخاب نماييد.  Yesذخيره شود، گزينه 

 

 ات مهم:نک

  در فيلدAuthor  به  يا مخفف آن)آن نام کوچک و بعد از  و يک فاصله ، سپس يک کامانويسندهابتدا نام خانوادگي

 را بگذاريد. همراه يک نقطه( ويک فاصله و سپس نام مياني )يا مخفف آن به همراه يک نقطه(

  با زدن کليد را هر نويسنده  مي باشد، چند نويسندهمنبع داراي در صورتي کهEnter بنويسيد. در يک سطر 

  در فيلد"Date" اگانه در فيلد تنها ماه و روز را بنويسيد. سال را جدyear .وارد نماييد 
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 .در هيچکدام از فيلدها سطر خالي وارد ننماييد 

 به کتابخانه شخصي جستجو در پايگاه اطلاعاتي/ ذخيره/ انتقال.1

ابتدا جستجوي خود را در پايگاه اطلاعاتي مورد نظرتان انجام دهيد. سپس نتايج دلخواه را به صورت يک فايل قابل خواندن 

براي انتقال داده ها به  ذخيره نماييد. در پايان اين اطلاعات را به کتابخانه شخصي خود انتقال دهيد. اندنوتفزار توسط نرم ا

 مي باشد که در هنگام انتقال داده بايد اين فيلتر براي نرم افزار انتخاب شود. نياز به يک فيلتر مناسب اندنوت

 از پايگاه  اطلاعات انتقالPubMed 

  وارد سايتPubMed .شويد 

 .جستجوي خود را انجام دهيد 

 .منابع مورد نظر خود را از نتايج جستجو انتخاب نماييد 

 

 

  در بالاي صفحه جستجو، گزينهSend to  را کليک نماييد. از قسمتChoose destination  گزينهFile  را

 يک کنيد.را کل Creat Fileانتخاب و گزينه  MEDLINEانتخاب نماييد. فرمت فايل خروجي را 
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  گزينهSave .را از پنجره مورد نظر انتخاب نماييد و فايل را ذخيره کنيد 

 

 

  براي اين کار: فرا رسيده است.  اندنوتاکنون نوبت به انتقال داده ها به 

ار و يا از نوار ابز Importبر روي گزينه  Fileنرم افزار را اجرا و کتابخانه شخصي تان را باز نماييد. از منوي الف( 

 باز مي شود. Import Fileپنجره  را انتخاب نماييد.   بالاي صفحه آيکون

 

 

 

 

 

 

 

در آن انجام داده ايد و را  جستجونام پايگاهي که فيلتر مناسب را انتخاب نماييد.  Import Optionب( در قسمت 

گزينه  Import optionدر قسمت  Pubmedجهت انتقال اطلاعات از  .نموده ايد، بيابيد نتايج را از آن ذخيره

Pubmed(NLM) .را انتخاب نماييد  

فايل ذخيره شده را بيابيد و وارد 

 کنيد.

از ليست نام پايگاهي 

که نتاج را از آن 

موده ايد، ذخيره ن

 بيابيد.

انتخاب کنيد که آيا منابع 

 تکراري هم وارد شوند؟
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 را براي حذف موارد تکراري انتخاب نماييد. Discarde duplicatesگزينه  Duplicatesدر قسمت  ( ج

 ، اطلاعات منابع با سرعت به کتابخانه شخصي شما انتقال مي يابد.Importبا کليک بر روي گزينه  ( ح

 سايت  انتقال نتايج جستجو ازGoogle Scholar 

  وارد شويد. در قسمت  تنظيمات اين سايتابتدا بايد به قسمت براي اين کارBibliography manager   يا

و کليد  تنظيم نماييد اندنوترا روي  Show links to import citations intoمدير فهرست منابع گزينه 

Save .را کليک نماييد 
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 ه مورد نظر گزينه بعد از جستجو ي کليد واژImport into Endnote  در زير هر رفرنس را کليک نماييد و کليد

Save .را بزنيد 

 

  مراحل انتقال اطلاعات مانند انتقال ازPubmed   است، فقط در قسمتImport option  از گزينه

Refer/BibIX .استفاده نماييد 

 :نکته

 در ليست  اييده نتايج را از آن ذخيره مي نماگر نام پايگاهي کImport Option  ،از فيلتر مي توانيدموجود نبود 

Reference Manager (RIS)  براي فايل هايي با پسوند.ris  مانند(1077.ris ) و يا Endnote 

Import  براي فايل هايي با پسوند.enw ( مانندcitation.enw ) استفاده  اندنوتجهت انتقال اطلاعات به

 نماييد.

نتايج جستجو از پايگاه هاي اطلاعاتي به کتابخانه  (Direct export)تقيم انتقال مس. 3

 شخصي

( توانايي … ,ISI, Scopus, Pubmed, Elsevier, Springerبسياري از پايگاه هاي اطلاعاتي مقالات )مانند 

ام جستجو لازم است که همزمان با انجدر اين روش  انتقال مستقيم نتايج جستجو را به کتابخانه شخصي فراهم مي نمايند.

 فايل اندنوت شما باز باشد.

  انتقال نتايج جستجو ازPubmed 

  وارد سايتPubMed .شويد 

 .جستجوي خود را انجام دهيد 

 .منابع مورد نظر خود را از نتايج جستجو انتخاب نماييد 
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  در بالاي صفحه جستجو، گزينهSend to  را کليک نماييد. از قسمتChoose destination زينهگ 

Citation manager   را انتخاب و سپس گزينهCreat file  را کليک نماييد. در اين قسمت از شما سوال مي

را انتخاب نماييد. به اين  openبر روي فايل مورد نظر انجام گيرد. گزينه  Saveيا  Openشود که کدام عمليات 

 انه شخصي اندنوت منتقل مي گردد. به صورت مستقيم به کتابخ Pubmedصورت رفرنس هاي انتخابي از 

 

  انتقال نتايج جستجو از سايتGoogle Scholar 

  با توجه به تنظيماتي که بر رويGoogle Scholar  انجام گرفته کافيست در زير هر رفرنس بر روي گزينه

Import into Endnote  کليک نماييد. در اين قسمت به جاي ذخيره کردن رفرنس گزينهOpen اب را انتخ

 نماييد به اين صورت رفرنس مورد نظر به صورت مستقيم به کتابخانه شخصي در اندنوت منتقل مي گردد. 

 

  انتقال نتايج جستجو از سايت Web of science (ISI)   

 ،گزينهبعد از انتخاب رفرنس هاي مورد نظر  ابتدا جستجوي خود را در اين پايگاه هاي اطلاعاتي انجام مي دهيم 

Save to other file format> Save to endnote   نماييدرا انتخاب.  
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  گزينه پنجره اين درSend  .را کليک نماييد 

 

 

  منتقل مي شود. توجه داشته باشيد  اندنوتمنابعي که انتخاب نموده ايد به صورت مستقيم به کتابخانه شخصي در

 Imported هاي انتخاب شده به زير گروه که کتابخانه شخصي شما در اين حالت بايد باز باشد، رفرنس 

reference .وارد مي شود 

  انتقال نتايج جستجو از سايتScopus 

  در بالاي صفحه بعد از انتخاب رفرنس هاي مورد نظر ، دهيدابتدا جستجوي خود را در اين پايگاه هاي اطلاعاتي انجام

 را کليک نماييد Exportجستجو گزينه 
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  گزينه  پنجرهدر اينRIS format  را انتخاب نماييد. کليدExport  در ادامه مي توانيد موارد انتخاب بزنيدرا .

به کتابخانه شخصي  Importآنرا از طريق  Pubmedشده را ذخيره نماييد و مانند مراحل گفته شده در بخش 

 .منتقل نماييد ندنوتاآنها را به صورت مستقيم به  Saveبه جاي  Openخود منتقل نماييد، و يا با زدن کليد 

 / انتقال به کتابخانه شخصيجستجو در پايگاه اطلاعاتي از طريق نرم افزار .4

به کمک اين شيوه مي توانيد به سادگي و بدون نياز به مرورگر اينترنتي به جستجو در ميان پايگاه هاي اطلاعاتي بپردازيد. 

نت متصل باشيد. براي استفاده از اين روش ابتدا کتابخانه شخصي بديهي است که در هنگام استفاده از اين شيوه بايد به اينتر

قرار دارد. تعدادي از پايگاه هاي  Online Searchرا باز کنيد. در منوي سمت چپ صفحه گزينه  اندنوتتان در نرم افزار 

د انجام جستجو در در اين قسمت قرار دارد. در صورتي که قص ISIو  PubMedاطلاعاتي که استفاده بيشتري دارند نظير 

فهرستي از پايگاه ها در پنجره اي نمايش داده مي شود. پايگاه را انتخاب نماييد.  moreپايگاه ديگري را داريد، گزينه 

 کليک نماييد. Chooseاطلاعاتي مورد نظر خود را انتخاب کنيد بر روي کليد 
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گام بعدي وارد کردن کليد کتابخانه شخصي شما قرار دارد.  پنل جستجو در بالاي صفحهيکي از پايگاه ها را انتخاب نماييد. 

بعد از جستجوي کليد واژه مورد نظر، پنجره بازيابي نتايج جستجو  واژه )هاي( جستجو براي پيدا کردن منابع مورد نياز است.

تعيين  اندنوتبراي انتقال به مي توانيد تعداد نتايج جستجو را تعداد منابعي که بازيابي شده را نشان مي دهد.  باز مي شود که

 منتقل شود.  اندنوترا کليک نماييد تا منابع به  OKو کليد 

 

ظاهر مي شوند.  Pubmedگروه موقت اتصال پايگاه هم در و   All Referencesدر منابع در کتابخانه شما دانلود و هم

 به صفر بر مي گردد. Pubmedوقتي شما کتابخانه را مي بنديد تعداد منابع موجود در گروه موقت 
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براي ساختن يک در قالب يک فولدر  PDFو يامجموعه اي از فايلهاي  PDFانتقال يک فايل  .5

 رکورد جديد

موجود در هر فايل  DOI2را، با استفاده از  PDFيک فايل و يا مجموعه اي از فايلهاي اين قابليت به شما اجازه مي دهد 

PDF اطلاعات  ،سيستممنتقل نماييد.  اندنوت، به کتابخانه شخصي خود درDOI  را با داده هاي موجود درCrossref 

)www.crossref.org(3  و اطلاعات کتابشناختي را از اين سايت دريافت مي کند و يک رکورد جديد در مطابقت داده

شماره  PDFحتما بايد به اينترنت متصل باشيد. در صورتي که فايل ايجاد مي کند. مسلما در زمان انتقال اطلاعات  اندنوت

DOI  نداشته باشد اطلاعات رفرنس منتقل نمي شود و فقط فايلPDF .به يک رکورد متصل مي شود 

 PDFمثال: انتقال يک فايل 

  کتابخانه شخصي خود را باز نماييد. از منويFile> Import> File حه آيکونو يا از نوار ابزار بالاي صف    

مورد نظر خود را که قبلا ذخيره نموده ايد انتخاب نماييد.  PDFفايل  Import Fileدر قسمت  را انتخاب نماييد.

  را انتخاب نماييد. PDFفيلتر  Import Optionدر قسمت 

 

 

  گزينهImport  فايل شما داراي شماره را کليک نماييد. در صورتي کهDOI  ل باشيد به اينترنت متصباشد و

 اطلاعات فايل مورد نظر به طور کامل به کتابخانه شما منتقل مي شود.

                                                           
1
 DOI   يا همانDigital Object Identifier که از دو  شناسايي اسناد الکترونيکي است يک استاندارد بين المللي جهت

  .از يکديگر جدا مي شوند”/“ ند تشکيل شده و به وسيله علامت بخش کد ناشر و کد س

3
 Crossref سازد تا به  کراس رفرنس محققان را قادر مي. را به نوعي مي توان اسکلت ارتباطات ارجاعي مقالات دانست

ر ژورنال و يا حتي ليک بتوانند از يک مقاله به مقاله ي ديگري سوئيچ کنند هر چند که آن مقاله دکراحتي با يک يا چند 

 مربوط به انتشارات ديگري باشد.

http://www.crossref.org/
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 مي توان با انتخاب يک فايل نکته :PDF  و درگ کردن در نوار آبي بالاي پنجره اندنوت فايلPDF  را به همراه

د بايد وجود داشته اندنوت منتقل نمود. توجه داشته باشيد که شرايطي که در بالا ذکر شاطلاعات رفرنس به پنجره 

 باشد تا اطلاعات رفرنس به درستي منتقل گردد. 

 PDFمثال: انتقال يک فولدر از مجموعه اي از فايل هاي 

  کتابخانه شخصي خود را باز نماييد. از منويFile گزينه Import> Folder .در پنجره را انتخاب نماييد Import 

Folder نموده ايد انتخاب نماييد. در قسمت  فولدر مورد نظر خود را که قبلا ذخيرهImport Option  فيلترPDF  را

موجود در فولدر مورد نظر به صورت رکوردهاي جداگانه  PDFرا کليک نماييد. تمام فايلهاي  Importانتخاب و گزينه 

 منتقل مي شود. اندنوتبه کتابخانه شخصي شما در 

 

 

  اندنوتمديريت اطلاعات وارد شده به 

 ي منابعگروه بند .1

بازيابي منابع راحت تر  ،تقسيم بندي نمود تا در زمان استفاده را مي توان به گروه هاي اختصاصي اندنوتاطلاعات وارد شده به 

 امکان پذير باشد.

  ساختن گوه عموميCustom group 

 .ابتدا منابع مورد نظر را که مي خواهيد در يک گروه باشند انتخاب نماييد 
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  از منويGroup نه گزيAdd Reference To  و سپسCreate Custom Group  را انتخاب نماييد و

 Create Customو سپس  Add Reference Toيا بر روي منابع انتخاب شده رايت کليک نموده 

Group .را انتخاب کنيد 

  در منوي سمت چپ نام گروه مورد نظر را وارد نموده وEnter وه قرار مي نماييد. منابع انتخاب شده در اين گر

 گيرد.

 

 

 

 

 ساختن گروه هوشمند Smart Group  : شما مي توانيدCustom group سپس نتايج جستجوي خود بسازيد ،

را در آن قرار دهيد، اما زماني که منابع جديد به کتابخانه شخصي شما افزوده شود بايد گروه شخصي خود را به 

. به صورت خودکار روزآمد شود بايد يک گروه هوشمند بسازيد که اين گروهصورت دستي روزآمد نماييد. براي اين

اين کتابخانه شخصي تعداد زيادي رفرنس با در  مثال براياساس کار گروه هوشمند بر روي استراتژي جستجو است. 

دارد. ما مي خواهيم گروهي بسازيم که رفرنس هاي مورد نظر را به ما نشان دهد و  وجود "Stem cell"کليد واژه 

 Createنماييد و گزينه  راست کليک My Groupبه صورت خودکار روزآمد شود. براي اين کار بر روي گزينه 



 Endnote X8راهنمای آموزشی 

 دانشگاه علوم پزشکي شيراز 28 

 

smart group و يا از منوي  ،را انتخاب کنيدGroup  گزينهCreate smart group .در  را انتخاب نماييد

و تژي جستجوي خود را تعريف استرا . سپسدنمايي اي گروه خود انتخابابتدا يک نام بر Smart groupپنجره 

 تا يک گروه هوشمند ساخته شود. کليک نماييدرا  createکليد 

 

 

تمام رفرنس ها با کليد واژه انتخاب شده هم اکنون در گروه هوشمند جديد قرار گرفته اند. هر گاه منبع يا منابعي به 

 مي هوشمند گروههاي ساختن جهتود.کتابخانه شخصي افزوده شود گروه هوشمند به صورت خودکار روزآمد مي ش

از گزينه هاي موجود در پنجره  بسازيم. هوشمند گروه نيز ايم داده مقاله هر به که اهميتي درجه اساس بر توانيم

Smart group گزينه Rating نماييم تعريف را خود گروه سپس و انتخاب را. 

 

 Group set گروه بکار مي رود. براي ساختن آن بر روي گزينه  لپن: براي دسته بندي گروهها در زير يک عنوان در

My group  کليک راست نماييد و گزينهCreate group set  را انتخاب و سپس نام دسته گروه خود را تعيين

مي  Group setرا انتخاب نماييد. در زير هر  Group> Create group setنماييد و يا با استفاده از منوي 

 را قرار دهيد.توانيد تعدادي گروه 
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  گروه ترکيبي(Combination group) براي سازماندهي بهتر رفرنس هاي اندنوت مي توانيد ترکيبي از گروه ها :

 براي ساخت گروه ترکيبي: ايجاد نماييد. AND, OR, NOTبا استفاده از عملگرهاي منطقي 

 Group> Createاستفاده از منوي  و يا با Create from groupگزينه  My groupاست بر روي ر. با کليک 1

from group .را انتخاب نماييد 

 مي شود نام گروه ترکيبي را انتخاب نماييد.. در پنجره اي که باز 2

 

گروه هاي مورد نظر خود را انتخاب کنيد و عملگر منطقي مورد نظر را  "Include reference in"در قسمت . 3

 انتخاب نماييد.
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گروه ظاهر مي شود. گروه  پنلانتخاب نماييد تا تغييرات ذخيره گردد. گروه ترکيبي شما در را  Create. گزينه 4

 شامل موارد مشترک با توجه به انتخاب شما مي باشد. 

 واستهحذف منابع ناخ .1

نماييد.  و کليک مي توانيد منابع را انتخاب کنيد( Ctrl)با پايين نگه داشتن کليد  براي حذف منابع ابتدا آنها را انتخاب 

 Move، و يا با کليک راست و انتخاب گزينه Move references to trash گزينه  Referencesسپس از منوي 

references to trash  .همچنين مي توان با درگ کردن موارد انتخاب منابع انتخاب شده را از کتابخانه حذف نماييد

قرار مي گيرد و کاملا حذف نمي شود. براي اينکه  Trashروه منابع حذف شده در گآنها را حذف نمود.  trashشده به 

و انتخاب  Trashو يا با کليک راست بر روي  Empty trashگزينه  Referencesمنابع کاملا حذف شود از منوي 

 منابع را به طور کامل حذف نماييد. Empty trashگزينه 

 

 

 Endnote Libraryيافتن متن کامل منابع موجود در  .3

از نوار ابزار بالاي صفحه کليک نماييد و يا  Find Full Text    نابع مورد نظر را انتخاب نماييد. سپس آيکونما ابتد

 را انتخاب کنيد. Find Full Textو گزينه راست روي منابع انتخاب شده کليک 
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در سمت  ن کامل آغاز شود.کليک کنيد تا جستجوي مت OKقانون کپي رايت را يادآور مي شود. روي  اندنوتدر اينجا 

را مشاهده مي کنيد که نشان مي دهد جستجو  Searching، گروه Find Full Textچپ صفحه، زير مجموعه گروه 

در حال انجام است. زماني که جستجو به پايان رسيد، براساس نتايج شما ممکن است ترکيبي از سه نوع گروه در زير 

Find Full Text .مشاهده نماييد 

1. Found PDF : منابعي را که فايلPDF .آنها يافت و به منبع متصل گردد نشان مي دهد 

1. Found URL : موجود باشد نشان مي دهد.  آدرس اينترنتي آنهامنابعي که 

3. Not Found : منابعي که نه آدرس اينترنتي و نه فايلPDF .آنها موجود نباشد در اين گروه قرار مي گيرند 
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مقاله را به منبع متصل مي نمايد.  PDF، در دسترس باشد، فايل پايگاه هايي که رايگان هستند در اگر متن کامل مقاله

توسط نرم افزار مورد استفاده قرار مي گيرد شامل همه پايگاه هاي رايگان  به ياد داشته باشيد الگوريتمي که به اين منظور

ا بيابد به معني آن نيست که متن مقاله موجود نمي باشد. نمي شود لذا در صورتي که نرم افزار نتواند متن کامل مقاله ر

دانلود نماييد و به منبع مزبور  با مراجعه به پايگاه داده هاي مختلف شما مي توانيد مطابق معمول متن کامل مقاله خود را

 در کتابخانه شخصي متصل نماييد. 

  به اطلاعات آن منبع ضميمه کنيم؟چگونه متن کامل مقاله، يا فايل هاي ديگر مرتبط با يک منبع را 

  باز کنيد. اندنوتکتابخانه شخصي خود را در 

  .بر روي منبع مورد نظر خود کليک نماييد. بر روي آيکون گيره در پنل تب ها کليک نماييد 

 

 

  در پنجره اي که ظاهر مي شود فايل مورد نظر را بيابيد و بر روي کليدOpen .کليک نماييد 
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 با انتخاب "آيا مي خواهيد تغييرات را ذخيره نماييد؟"وي يک منبع ديگر، از شما سوال مي شود که با کليک بر ر ،

 تغييرات ذخيره مي شود. Yesگزينه 

 

 

فايل هاي ضميمه شده همراه با فايل اصلي کتابخانه شخصي تان ذخيره مي شود. به اين ترتيب فايل ضميمه شده 

 منابع را هميشه در اختيار داريد.

کتابخانه شخصي شماست، لذا به ياد داشته  "Data"لازم به يادآوري است که محل ذخيره فايل هاي ضميمه پوشه 

را به همراه فايل کتابخانه خود داشته باشيد  "Data"باشيد براي دسترسي به فايل هاي ضميمه شده هميشه پوشه 

 را نيز انتقال دهيد. "Data"امپيوتر ديگر پوشه و در صورت نياز به انتقال کتابخانه شخصي از يک کامپيوتر به ک
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  نوار ابزارPDF 

 جام کار مي باشد.نظاهر مي شود و  داراي آيکون هايي جهت تسهيل ا PDFاين نوار ابزار درون پنل نمايش 

 

 رتبه بندي منابع موجود در ليست کتابخانه شخصي .4

خود بر اساس ميزان اهميت رتبه اي اختصاص دهيد. براي شما مي توانيد به هر يک از منابع موجود در کتابخانه شخصي 

را انتخاب و امتياز منبع مورد  Ratingنماييد. گزينه راست اين کار ابتدا يکي از منابع را انتخاب نموده و روي آن کليک 

 نظر را تعيين نماييد. 
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 ابعمن به( Mark as read/unread) نشده يا شده خوانده عنوان به يک برچسب اعمال .5

 در منابع کدام اينکه پيگيري شخصي يک برچسب اختصاص دهيد به منظور کتابخانه در شما مي توانيد به منابع موجود 

را انتخاب نماييد.  Mark as readو گزينه راست کليک  روي منبع مورد نظر .اند شده بررسي شما توسط تحقيق طول

 ده مي شوند. به صورت کم رنگ تر در ليست مشاهمنابع خوانده شده 

 

 به روز رساني رفرنس ها در اندنوت

ه نس شويم. از نوار ابزار بالاي صفحبراي اينکار ابتدا بر روي رفرنس مورد نظر دوبار کليک ميکنيم تا وارد صفحه ويرايش رفر

ي شود م زدر اينجا پنجره اي با را انتخاب مي کنيم. Reference > Find reference updateيا از منوي    آيکن

که در قسمت سمت چپ تغييرات و به روز رساني موجود و در قسمت سمت راست اطلاعات رفرنس وارد شده را نشان مي 

 مي توانيد تغييرات را اعمال نماييد. توجه داشته Update empty fieldsيا  Update all fieldsدهد. با انتخاب گزينه 

حتما فيلدهاي نويسنده، عنوان، سال را چک  Update. قبل از انجام باشيد که اين عمل هميشه درست انجام نمي گيرد

 نماييد و از صحيح بودن اطلاعات بازيابي شده اطمينان حاصل نماييد.
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  2007 ورددر محيط  اندنوتآشنايي با نوار ابزار 

در کنار  اندنوت خود نصب نماييد. زبانهروي کامپيوتر  کافيست اين نرم افزار را بر وردبراي مشاهده اين نوار ابزار در نرم افزار 

  باز مي شود. اندنوتها قرار مي گيرد و با کليک بر روي آن نوار ابزار  بقيه زبانه

 

 Goرا باز نماييد. در پايين صفحه کليد  Add-Insزبانه   و  Word Option نبود، پنجره  ورددر صورتي که اين زبانه در 

 را بزنيد.

 

 

را بزنيد. به اين  OKرا انتخاب نماييد و کليد  Endnote Cite while you writeگزينه  COM Add-Insدر پنجره 

 افزوده مي شود.  ورددر صفحه   اندنوتترتيب زبانه 
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 چگونه در حين نوشتن مقاله، ارجاع ها را وارد کنيم؟

ام تايپ دست نوشته خود، مي توانيد هنگ ورددر محيط   Cite While You Write (CWYW)با استفاده از ويژگي

مي  هاي درون متني را وارد کنيد و البته به طور خودکار فهرست منابع پايان متن نيز ساخته مي شود. براي اين کارداستنا

 روش زير عمل نماييد:توانيد به يکي از دو 

 :ورددر محيط  Insert citationاستفاده از آيکون  .1

 تايپ شده، باز نماييد. وردمورد نظر خود را که در نرم افزار  تنم 

  ،آيکن   اندنوتاز نوار ابزار مکان نما را دقيقا به جايي ببريد که ماخذ بايد درج شودInsert citation  گزينه

Insert Citation  نماييد. انتخابرا 
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  صفحهFind & Insert my references و گزينه  باز مي شود. يک جستجوي کليد واژه اي انجام دهيد

Find نتايج جستجو به نمايش در مي آيد. منبع جستجو در کتابخانه شخصي شما انجام شده و . را کليک نماييد

 کليک نماييد. Insert)هاي( مورد نظر خود را انتخاب و روي کليد 

 

 

  ظاهر مي شود.  متنمآخذ در محل پيش بيني شده درج خواهد شد و اطلاعات کامل کتابشناختي مقاله در پايان 

 

  اندنوتدر محيط  Insert citation استفاده از آيکون  .1

  ،مکان نما را دقيقا به جايي ببريد که ماخذ بايد درج شود. سپس روي آيکون در متن مقاله در حال تايپ خودGo 

to Endnote   کليک نماييد. اندنوتاز نوار ابزار 
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 ( مورد نظر خود را بيابيد و با کليک روي آن، در ليست رفرنس هاي موجود در کتابخانه شخصي خود، رفرنس )هاي

 .(و کليک مي توانيد بيش از يک رفرنس را انتخاب نماييد Ctrlآن را انتخاب نماييد. )با گرفتن کليد 

  اکنون با کليک بر روي آيکون Insert citation مآخذ در محل پيش بيني شده درج خواهد شد و اطلاعات کامل ،

 ن ظاهر مي شود.کتابشناختي در پايان مت

 

 

 رفرنس نويسي (Style)انتخاب يک سبک 

اندنوت اين امکان را به شما مي دهد تا فرمت استنادها و رفرنس هاي پايان متن خود را بر اساس نيازتان تغيير دهيد. براي 

  سبک مورد نظر خود را انتخاب نماييد. Style، از گزينه ورداينکار در تب اندنوت در بالاي پنجره 

 

 

 :سبک نوشتن منابع و مآخذ وجود دارد. نصب معمولي نرم افزار تنها مشهورترين  سبک ها را  4544بيش از  نکته

 شامل مي شود. 

 مورد نظر در اين قسمت موجود نبود مي توانيد به روشهاي زير عمل کنيد:  styleدر صورتي که 
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مراجعه کنيد. وارد تب   www.endnote.comه سايت نبود مي توانيد ب Styleدر صورتي که سبک مورد نظر در ليست  .1

Download  شده و گزينهOutput styles> add output style  .را انتخاب نماييد 

 

 

 

 را کليک نماييد. Applyوارد کرده و گزينه  style or journal nameنام ژورنال مورد نظر را در قسمت 

http://www.endnote.com/
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وجود دارد. روي آن کليک نماييد و  فايل مورد نظر را  Download، در مقابل نام ژورنال گزينه Styleبراي ذخيره کردن 

ذخيره نماييد. به اين صورت سبک مورد نظر به ليست  Styles، فولدر  اندنوت ، فولدرprogram files، فولدر Cدر درايو 

 افزوده مي شود. اندنوتسبک هاي موجود در 

نصب کنيد. در صورتي که  اندنوتدر روش ديگر مي توانيد تمام سبک ها را با برنامه : انتقال تمام استايل ها در زمان نصب .2

 changeگزينه  بالاشويد و در  Control panel>Program and featuresنرم افزار را قبلا نصب نموده ايد وارد 

 را انتخاب نماييد. 
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علامت + را کليک کنيد تا ليست موضوعات  Additional styleنماييد و در مرحله بعدي در کنار را انتخاب   Nextگزينه 

 مورد نظر ظاهر شود. 
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افزوده شود انتخاب نماييد و با کليک بر روي منوي  Stylesاز ليست موضوعي هر کدام از موضوعات را که تمايل داريد در 

 را انتخاب نماييد. …Will be instuled onکرکره اي کنار آن گزينه 

 

هاي جديد به  Styleرا کليک نماييد و مراحل نصب را به ترتيب تا آخرين مرحله ادامه دهيد. به اين ترتيب  Nextکليد 

 افزوده مي شود. اندنوتليست موجود در 

 

مربوط به نحوه نوشتن ژورنال مورد نظر و بخش  درشما بايد صفحه راهنماي نويسندگان در اين روش ابتدا : styleويرايش  .3

را  style> select another styleرفرنس ها را مطالعه نماييد. در مرحله بعد در کتابخانه شخصي اندنوت قسمت 

را انتخاب نماييد. حال با انتخاب هر استايل  Style Info/ Previewگزينه  choose a styleانتخاب نماييد. در پنجره 

 نس در پنجره پايين نمايش داده مي شود. در پنجره بالا، نحوه نوشتن رفر
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براي به اين ترتيب شما مي توانيد شبيه ترين استايل به استايل مورد نظر را انتخاب و در مرحله بعد آن را ويرايش نماييد. 

فتن در ، با اين تفاوت که عدد رفرنس درون متني به جاي قرار گرباشد NLMمثال اگر استايلي مورد نظر ما مشابه استايل 

قرار بگيرد و به صورت بالانويس باشد، و همچنين در رفرنس هاي پايان متن نام ژورنال به صورت  [ ]پرانتز بايد در براکت 

 يک استايل جديد بسازيم. براي اينکار: NLMايتاليک باشد و يا فيلدي اضافه يا کم داشته باشد، مي توانيم با ويرايش استايل 

  از منويEdit> output style> Edit "NLM" .را انتخاب مي کنيم 
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  در پنجره اي که باز شده در ستون سمت چپ الگوي نوشتن استايل مشخص گرديده. ابتدا بايد به قسمت

Citations> templates  برويم تا رفرنس درون متني را تعريف کنيم، در پنجره سمت راست در زير

Citations نمايش داده شود. براي مثال ابتدا پرانتز   صورت هچ مشخص مي کند که رفرنس درون متني به

(Bibliographic number)  تبديل مي کنيم سپس آن را انتخاب کرده و از نوار ابزار بالا گزينه  [  ]را به

 را انتخاب مي کنيم تا به صورت بالا نويس قرار بگيرد. 



 Endnote X8راهنمای آموزشی 

 دانشگاه علوم پزشکي شيراز 46 

 

 

 

  براي تغيير قالب رفرنس هاي پايان متن به قسمتBibliography> Templates  .در اين قسمت مي رويم

نوشتن رفرنس براي انواع مختلف رفرنس مانند کتاب، ژورنال، صفحه وب و .... نوشته شده است. در اين قسمت  الگوي

 هر تغييري که لازم باشد انجام مي دهيم. 

  در پايان از منويFile> save as  را انتخاب و يا با بستنX  پنجرهEdit style سوال مي پرسد که آيا  از شما

 تغييرات را ذخيره مي نماييد. 

 کنيم و تغييرات را ذخيره مي نماييم. به اين ترتيب يک استايل جديد به  يک اسم جديد براي استايل انتخاب مي

 ليست استايل ها افزوده مي شود. 

لا امکان پذير نباشد، شما مي توانيد نظر از هيچ يک از راه هاي با در صورتي که تهيه استايل مورد: ساختن استايل جديد .4

 يک استايل جديد با قالب مورد نظر بسازيد. مراحل کار به اين صورت است: 

  از منويEdit> Output style> New Style .را انتخاب نماييد 
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 .پنجره اي باز مي شود که مي توانيد مرحله به مرحله مشخصات استايل را تعريف نماييد 

  قسمتهاي مختلف مانند از ستون سمت چپAbout this style, Citations, Bibliography  و .... را

 مورد نياز در هر فيلد را تعريف مي نماييم.  الگويانتخاب مي کنيم و در ستون سمت راست 
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 ختن استايل جديد( در فايل استايلي که جديد ساخته ايد )به روش ويرايش و يا سا: نکتهDocuments  در پوشه

 مي باشد. ens.ذخيره مي شود. پسوند اين فايل  ت استايلدنوان

Term Lists 

مي شود. به طور مثال در  Author, Journal, keywordsوجود دارد که شامل  Term listsدر اندنوت قسمتي به نام 

Journal term lists آمده است. در  تعداد زيادي ژورنال که نام آنها به صورت کامل و مخفف در دو رديف مقابل هم

مواردي هنگام نصب اندنوت ليست مخفف نام ژورنالها بوجود نمي آيد. به اين ترتيب زمانيکه شما استايلي را انتخاب نماييد که 

نام ژورنال در آن بايد به صورت مخفف باشد، به دليل اينکه اين ليست در اندنوت موجود نيست، نام ژورنالها را به صورت کامل 

 ي رفع اين مشکل به طريق زير اقدام نماييد:مي آورد. برا

 را انتخاب نماييد. Tools> Open term lists> Journal term listsدر پنجره اندنوت از منوي  .1
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 Listsنام ژورنالها و مخفف آنها را نشان مي دهد و تب  Termsدو تب وجود دارد. تب  Term listsدر پنجره  .2

 جديد را به شما مي دهد. امکان اضافه کردن نام ژورنالهاي
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 را کليک نماييد. Import listرا انتخاب نماييد. سپس گزينه  Lists> Journalsاز تب  .3

 

در پنجره اي که باز مي شود فايلهايي وجود دارد که حاوي نام ژورنالها است. هر کدام از اين فايلها با موضوع مشخص  .4

و .... را انتخاب  Medical, Bioscienceظر خود را به طور مثال شده اند. هر کدام از زمينه هاي موضوعي مورد ن

 را مي زنيم. به اين ترتيب ليست ژورنال ها به اندنوت منتقل مي شود. Openمي کنيم و گزينه 
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 را مي بنديم.  Term listsرا مي زنيم و سپس پنجره  OKکليد  .5

نتقل مي شود و در مواردي که لازم باشد نام ژورنال به به اين ترتيب ليست نام ژورنالها و مخفف آنها به اندنوت م

 صورت مخفف آورده مي شود. 

 وردويرايش و مديريت استنادها در 

ويرايش و مديريت نماييد. از نوار ابزار  وردبا استفاده از اين بخش مي توانيد استنادهاي درون متني و پايان متن را در محيط 

پنجره اي باز مي شود که تمام منابع استفاده شده در را انتخاب نماييد.  Edit & Manage Citationsگزينه  اندنوت

 هر منبع مي توانيد در موارد زير استفاده نماييد. آبشاريمتن را نمايش مي دهد. از منوي 

 Remove Referencesحذف يک ماخذ  .1

 Insert Referencesاضافه نمودن ماخذ  .2

  Edit Library Reference ويرايش منبع در کتابخانه شخصي .3
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 :نکته

با  و ذخيره آنبعد از ويرايش در هر يک از منابع موجود در کتابخانه شخصي ويرايش و تغييري انجام گرفت، در صورتي که 

تغييرات را در مآخذ موجود در متن اعمال  ورددر فايل  ،Update Citation & Bibliographyکليک بر روي گزينه 

  نماييد.

 

 

  نوت گزينهتب انددر Instant formatting  بايدOn  باشد تا کليدUpdate Citation & Bibliography  فعال

 شود.

 

 

ترتيب مي توانيد هر  . به ايناستفايل اندنوت متصل  تهيه گردد، بهکه رفرنس هاي آن با استفاده از اندنوت  ورد:  فايل نکته

را از اندنوت  وردو ...(. براي اينکه اتصال فايل  مانند تغيير استايل، اضافه و يا حذف نمودن رفرنس) در آن اعمال نماييدتغييري 

را انتخاب Convert citation & bibliography> Convert to plain text  گزينه اندنوتقطع نماييد. از تب 

ک فايل جديد ساخته مي شود که مشابه فايل اول ي OKنماييد. از شما سوال مي شود که آيا ادامه مي دهيد. با کليک کردن 

 است ولي اتصال آن از اندنوت قطع شده است. 

 تهيه خروجي از ليست رفرنس ها 

 : وردتهيه خروجي از اندنوت به  .1

 .براي اين کار ابتدا رفرنس هاي مورد نظر و يا تمام رفرنس ها را انتخاب مي نماييم 

   از منويFile> Export  را انتخاب مي کنيم.    ابزار گزينهو يا از نوار 

  در پنجره اي که باز مي شود ابتدا نام فايل را  انتخاب مي کنيم. سپس در قسمتSave as type  شکل فايل را

Rich text format  قرار مي دهيم. و در پايان استايل مورد نظر را انتخاب مي نماييم و کليدSave  .را مي زنيم 
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 ي از رفرنس هاي انتخابي بر اساس استايل مورد نظر تهيه مي شود.به اين ترتيب يک خروج 

 

 به اندنوت وردتهيه خروجي از فايل  .1

)که به اندنوت متصل بوده است( در اختيار  وردگاهي اوقات ممکن است فايل اندنوت در دسترس نباشد و يا فقط فايل 

نه اندنوت بسازيد و از رفرنس هاي خروجي تهيه نماييد. يک کتابخا وردشما باشد. مي توانيد با استفاده از همين فايل 

 براي اين کار:

  از تب اندنوت گزينهExport to Endnote> Export traveling library .را انتخاب کنيد 

 

 

 د بر روي کامپيوترتان را انتخاب کنيد و يا يک وپنجره جديدي باز مي شود که مي توانيد که کتابخانه اندنوت موج

 نه اندنوت جديد بسازيد.کتابخا

  بعد از انتخاب يکي از موارد بالا کليدOK .را مي زنيم 
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 .کتابخانه اندنوت در مکان مورد نظر ذخيره مي شود 

  پيامExport complete  .از رفرنس هاي موجود در فايل  به اين ترتيب يک کتابخانه اندنوترا نشان مي دهد

 ساخته مي شود. ورد

 وردرنس ها در دسته بندي کردن رف

. زماني که اندنوت رفرنس هاي پايان نماييددسته بندي موضوعي  ورددر فايل را اين قابليت به شما اجازه مي دهد رفرنس ها 

 را اضافه مي کند، استنادها را بر اساس دسته بندي سازماندهي مي کند. جهت دسته بندي کردن رفرنس ها: وردمتن 

 را انتخاب کنيد. Categorize referencesگزينه  ورداز تب اندنوت در  .1

 را انتخاب نماييد. Configure categoriesگزينه  .2

 

 

با کليک  Category headingsد. در قسمت ورفرنس ها را گروه بندي نم واندر پنجره اي که باز مي شود مي ت .3

مت وجود در پنجره س، و با درگ کردن رفرنس هاي مراست بر روي هر سرعنوان مي توان نام آن را عوض کرده

 د.راست به هر سرعنوان، مي توان آن را دسته بندي کر

 دسته بندي بر روي رفرنس ها اعمال مي گردد. OKبا زدن کليد  .4
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 متناسب با مجلات وردساخت چهارچوب فايل 

هارچوب به اين براساس قالب هاي از پيش تعريف شده در اندنوت بسازيد. براي ساخت اين چ وردشما مي توانيد يک فايل 

 شکل عمل نماييد:

 را انتخاب کنيد. Manuscript templatesدر اندنوت  Toolsاز منوي  .1
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 را بزنيد. Openاز پنجره باز شده قالب ژورنال مورد نظر را انتخاب نماييد و گزينه  .2

ر نوشتن مقاله جديد باز مي شود که براساس قالب ژورنال مورد نظر تنظيم شده است که به شما د ورديک فايل  .3

 کمک مي کند.
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 در فايل مورد نظر اطلاعات خواسته شده مانند عنوان، چکيده، و ... را به ترتيب وارد نماييد. .4

 <endnote.comنبود مي توانيد از سايت Manuscript templateنکته: در صورتي که قالب مورد نظر شما در 

manuscript  را دانلود کنيد و در پوشهtemplate ر محل نصب نرم افزار اندنوت وارد نماييد.د 


